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Intro to Creating Your Own Workbooks, Checklists & Journals 
 
Thank you for joining the Workbook Masterclass.  
 
In the Workbook Masterclass, I show you how to create your own workbooks, 
checklist or journals.  We will be looking at your books, coaching, consulting, or 
teaching and pulling out the key content or path and create a workbook. 
 
Our books, coaching, consulting and teaching take our readers, clients, or 
students on a journey. We move them from point A to point B. They go on a 
journey of discovery and learning. Hopefully, there is a transformation that takes 
place as they start to understand what we are saying and teaching.  
 
A workbook becomes an excellent companion on this journey. It helps your 
reader or client move through your material and either learn or through self-
awareness understand and retain what you are trying to say.  
 

 
 
We use our workbooks as a tool or roadmap to help guide our reader, client, or 
student to the lessons we are teaching. We also use our workbooks as additional 
products. It is a way to monetize our books and coaching. Workbooks are often 
seen as more valuable than the original book. The book, coaching or teaching is 
the theory, the workbook, study guide, or checklist is the practical. It is a way of 
pulling out the lessons and key points of our content.  
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What is the journey that you take your reader, client or student on? What are you 
teaching? 
 
 
 
 
 
 
 
 

 
 
To just get your thinking started, what are several key steps that you take your 
reader, client or student through? We will dig deeper but just the rough outline. 
 
 
 
 
 
 
 
 

 
 
A book and workbook form a bundle, a new product. Add in some videos around 
each section and we have a course. Our books might start at $19.95 add a 
companion workbook for $47.95, add a few videos and now we have a $199.95 
course. Teaching a class or workshop you might be able to sell 25 or more 
workbooks at each session. Your book just became way more valuable.  
 
If we are coaching or consulting, workbooks and checklists give our clients 
something to do and keep them engaged. It is the take away document. It can 
guide our clients along our path. It is where they can write down the key points 
they are learning. It also gives us a great place to distribute additional 
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information, resources, bios, access to other products and programs. The 
workbook makes us look more professional and lets our clients know they are 
included in our program. They belong to our group now.  
 
The internet marketer Mike Koenigs has a saying, “busy fingers are happy 
fingers.” A workbook is a great way to keep people engaged with your material. 
Especially now in this Zoom online world.  You can run an online or live training 
session and give your participants something to do.  
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Types of Workbooks 
Workbooks include, roadmaps, blueprints, checklist, study guides, 
journals. Printable workbooks, PDFs, 3 ring, single page worksheets, 
participants and leaders’ workbooks, client questionnaires. Even online 
planning products like Trello boards, Asana and MS Planner, which are 
collaborative tools for organizing your projects for yourself and your 
clients are really workbooks. 
 
Examples of Several Workbooks 
• Let’s Get Started Worksheet Templates for the Workshop 
• Self-Publishing SECRETS, Checklist 
• Brenda Sullivan, My Garden Journal 
• Russell Brunson, One Funnel Away Challenge, SECRETS collection. 
• MML Journal Book 
• Essential Music Chords, Blank Sheet Music 
• Daily Geography Practice Teacher Book 
 
Look around your office or workspace, you will probably see several 
workbooks. What are they and what do you like or dislike about them? 
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The Hidden Treasure in Your Content 
• Looking at your book, coaching, consulting and teaching 
• Outlining your book content for key steps 
• Planning your consulting, coaching and teaching workbook 
• Ideas to think about 
 
• Workbook Case Study Examples 
 
Looking at Your Book, Coaching, Consulting and Teaching 
This is the messy part, and my favorite part, finding the Hidden 
Treasure in Your Content. Many of us have written a book of some kind 
or we work with clients or students. We take them on a journey. We 
teach them things about the world or about themselves. There is a path 
to the process. They come to us for guidance. Often asking some 
version of the question, “I don’t know what comes next?” That is our 
job to give them that information and show them the path. 
 
The goal of this section is to look at your content and your process. You 
can think of your workbook, checklist, journal, study notes and more as 
an outline of the process. You give people the key points and a way of 
recording and being engaged with what they are learning. These can be 
questions, checklists, exercises, charts, resources, tasks, etc.  
 
Outlining Your Book’s Content for Key Steps 
Many of us already have this outline. For a book just start with your 
chapter titles. Then look into each chapter and pull out the key parts. 
What are the questions you are answering? Some authors add 
discussion or thought questions at the end of each chapter. Right there 
you have a workbook. In your word processing program, layout the 
chapter titles for each section on a page and then add the questions. 
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Below each question add space, lines or a box to write answers, and 
you have created a workbook.  
 
If your book doesn’t have questions then we take the key points, 
actions, and ideas and turn them into a question or steps. We might 
also create a checklist or a calendar. In my book The Self-Publishing 
SECRETS, I write about creating a launch team for your book. If I 
wanted to create a book launch workbook that I can sell, I might do 
something like this. 
 
 
“5. Set up some launch day interviews.”  
You could create some questions for the interviewer. 
 
What are some sample questions that I could send to the person who is going to be 
interviewing me? List out five. 
 

1. 

2. 

3. 

4. 

5. 

 
 
  



 
 

 © Copyright J. Bruce Jones 2020  •  BruceTheBookGuy.com  •  10 

“6. Set up a launch team. Team members should buy a copy of the 
book and post an honest review on Amazon. Also try to find some 
international team members to help with the launch.” 
 
I am turning a statement from the book into a task or question. 
 
Identify five people that can be on your book launch team. Fill in their names, phone 
numbers and email addresses. 
 

Launch Team Members Phone Numbers Email Address 

   
   
   
   
   

 
Or create a checklist 
 
Book Design Interior Elements: eBook and Print Book 
You may not have all of these, but this is a good place to start, check off 
what elements you have for your book. 

¨ Title page ¨ The manuscript 

¨ Disclaimer and legal info ¨ Author bio 

¨ Copyright notice ¨ Author services or products 

¨ Table of contents ¨ Index 

¨ Introduction ¨ Resources 

¨ Acknowledgement ¨ Dedication 

¨ Other______________________________ 
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If you have written a book, write down several possible questions or 
tasks from it. 
 
1. _______________________________________________________ 
 
2. _______________________________________________________ 
 
3. _______________________________________________________ 
 
4. _______________________________________________________ 
 
5. _______________________________________________________ 
 
 
Planning Your Consulting, Coaching and Teaching Workbook 
Books are often an easier thing to develop a companion workbook for. 
You have already figured out the path and it is written down in the 
book. If you are using your book to teach from or develop a program 
from then you can use it as the base for your workbook. Your job is look 
at it and create the outline, questions, checklists and resources that go 
along with it.  
 
Consulting, Coaching and Teaching is tougher. You don’t always know 
where you are going with it. If you are a teacher and working with 
students you probably have some kind of curriculum that you are 
following. You can base your workbook on that, develop questions and 
related exercises. 
 
Consulting and coaching is a bit messier, but you most likely have a 
process. You will often help your clients in a similar way based on their 
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needs. You start at A and move them to B. The object is to write that 
process down and figure out related questions, checklists and tasks that 
go along with it and that can help them. You don’t have to cover every 
step. Workbooks for consulting, coaching, programs and general 
business can be very varied. Some might outline a program with 
schedules, to do steps, tasks, lots of questions etc. Some might just be a 
place to record what the participant is learning, more like a diary. Some 
might follow the PowerPoint presentation and take the same text and 
give your participant a place to record additional information. You want 
to help keep them engaged and give them a takeaway. There are no 
rules, they can be whatever you want. Your workbooks can be printed, 
downloadable PDFs, full on books or just a couple of pages, more like a 
worksheets.  
 
The workbook is there to give your clients a place to record the 
information and help them organize it. In Grahame Rees, Aussie Ranch 
Tour of the West example, (see Grahame Rees’s case study video) he 
just included space in the workbook for each rancher to record the 
daily visits to the places they visited and what they learned. It was 
mostly just recording information, more like a daily diary. Workbooks 
help give your program a professional look. People expect to have 
something to take notes in. It helps anchor the program.  
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Ideas to Think About 
 
• This is a key point, you don’t have to write a book for your 
workbook. Your workbook can be one page, more like a handout. If you 
are starting out and you want to develop a workbook for your program, 
start with a one-page questionnaire, or a checklist, or a resource list. 
Hand it out and see what the reaction is and then adjust. Then add two 
pages and move out from there. Your clients will be just happy with the 
one page as they are with the book.  0:18 
 
• You don’t have to publish a book. You might just need to photocopy 
several pages. If your program is online let people download and print 
out a PDF. You can also create a fillable PDF and they can write their 
answers right on the computer. Only be as long as you need.  1:04 
 
• Online and live programs move fast. Programs often have a lot of 
information and steps coming at you. It is hard to keep track of it all. 
We often don’t process a program until we are home and can think 
about it. The workbook can slow the process down and help your 
participant organize and understand it. It helps keep people engaged in 
your event. Give people action steps and resources that they can use 
after they have left the event.  1:50 
 
• The workbook is an excellent marketing tool as participants show 
others the cool event they went to. It helps them explain it and what 
they learned to others.  3:17 
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• A simple checklist or resources list can be an excellent lead magnet 
on your website. It is a great way to bring someone into your world. Set 
up a button on your website, give the PDF checklist away in exchange 
for their email address. You can also sell these resources. 
 
• If you are teaching a process that moves along step by step, like how 
to paint or how to set up a garden, show the steps. Take pictures of 
each step, put them on one side of the page, add a section to write 
down additional information on the other side. You have a course step-
by-step workbook.  5:15 
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Workbook Case Studies 
 

 
 
CASE STUDY Create an Event, Create a Workbook, Grahame Rees, we 
reversed the process. Grahame started with the workbook and then 
created a book.  
 
In 2019 Grahame led 22 Australian ranchers and farmers around the 
Western United States on the Aussie Graziers USA Ranch Tour. The 
purpose was to visit Western USA ranches over 21 days and exchange 
ideas and learning on regenerative and profitable agriculture. The trip 
was a huge success. Each participant kept a workbook and recorded 
their thoughts and experiences on the trip. Once the trip was done 
Grahame pulled together a book that included the results of the visits 
to each ranch and the key takeaways. This is an excellent way of using 
an experience to create a book. After the event Grahame sent the book 
out to each participant and the ranches that they visited. The book is 
now part of the experience for each participant, the ranches they 
visited loved the gift and he has a great marketing tool for future trips. 
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CASE STUDY Book and Discussion Groups, Ed Gaskin, Latanya Gangs, 
Girls and Guns, book, workbook and leaders guide. 
 
I have a friend of mine, Ed Gaskin. Ed published a book of short 
stories/skits about urban teen girls who have gang member boyfriends 
and all the issue that come with it called, Latanya: A Story of Gangs, 
Girls and Guns. This book is about gang violence as told from the 
perspective of women, sisters, girlfriends and mothers. It was based on 
a campaign called “I Choose Me” from the Boston Ten Point Coalition. 
The girls and women are often pulled into a world of violence because 
of their relationships. This violence is often directed at them.  
 
The book included 34 discussion questions that were developed with 
help from youth counselors and a resource list. After the book was 
published Ed discovered that the book was being used in teen girl 
discussion groups around these topics. Exactly what he wanted. He 
then developed a companion workbook for the girls to use in group 
discussions. The workbook takes scenes from the book and asks 
questions around them. This is a perfect use of a companion workbook. 
After that he developed a companion Leaders Guide with additional 
resources and spaces for answering questions. The Leaders Guide was 
is helpful for bringing group leaders up to speed on these issues. From a 
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business side you sell one book, but now with a workbook you can add 
on a bulk order of many more. Each girl needs one.  
 
Latanya: A Story of Gangs, Girls and Guns 
Latanya: A Story of Gangs, Girls and Guns, Workbook & Leader’s 
Guide 
 
There are many books like this. Books that have questions in the text or 
at the ends of the chapters. It is a simple matter to pull those questions 
out, edit a little, add space or lines for answers and you have a 
workbook. You can add lines or boxes or just space to each question for 
writing comments and ideas. What I really like about what Ed did was 
to create a leader’s guide from the book. You could make a book like Ed 
did or three. The original book, one with questions and spaces to write, 
and the other a true leader’s guide with exercises and resources.  
 
Idea: Ed created another book on domestic violence called Stories from 
a Domestic Violence Advocate. In this book Ed create a series of script 
like stories based on actual cases from several counsels. There are a 
series of characters that move through the book with the stories. 
Victims of domestic violence will connect with and use the characters in 
these stories to talk about their own experiences. Ed then worked with 
the domestic violence counsels and had them write the questions for 
the book. The book has become a tool for counsels to use.  
 
Ed’s idea is to create a book around your topic, adding lessons, 
discussion questions, supporting and background materials, suggested 
speakers and resources. Create a roadmap or leadership guide for the 
user.  
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CASE STUDY Creating Checklists and Workbooks from Your Book, 
Nancy May, How to Survive 911 Medical Emergencies, how to create a 
workbook from an existing book. 
 
I am so pleased to have Nancy’s book as an case study. We talk about 
her new book but also publishing and marketing. Nancy created a book 
on how to deal with 911 medical emergencies. The book is designed for 
a family member who is taking care of an elder parent, family member 
or has a business or service that needs this information. Her book is 
packed full of checklists and steps you need to take and be aware of. It 
is perfect for creating a series of workbooks and checklists. It is all 
written in the book, we just need to take it out and create the checklists 
and workbooks. We talk about these and how to distribute and publish 
them. We also dive into how to use checklists to market your book and 
products.  
 
Checklists and workbooks make great marketing tools to bring people 
into your world. This is a fun interview with a lot of great take away 
info. 
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Video 5 Tools for Creating Your Workbook 
• MS Word, Google Doc, Open Office 
• MS PowerPoint, Google Slides, Keynote 
• Adobe InDesign 
• Apple Pages 
• Canva.com 
• Pixabay.com stock images, UpSplash.com 
 
Video 6 Publishing Your Workbook 
Amazon, PDF, Fillable PDFs, Printable Workbooks,  
• Book 
• Workbook 
• Book + Workbook = Bundle 
• Add an audio or video component 
• Book + Workbook + Audio or Video = Course 
 
Video 7 Marketing Your Workbook 
• Using it in your training and programs 
• Cross promoting in your books 
• Social Media, Instagram, Pinterest, YouTube, Facebook 
• Selling your workbook on Amazon, Gumroad, your blog 
• Talking about it in your podcast, video 
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Video 8 Design 101 for Workbooks 
• Consistency 
• Spacing 
• Fonts 
• Head, Subheads 
• The Grid-making your pages look great 
• Branding 
 
Products You Can Make Based on Your Workbook 
Workbooks, checklist, study guides, journals, audio, video, courses, lead 
magnets 
 
• Your original book 
 
• Your coaching program, consulting, training, and teaching 
 
• Add to your book or program a companion workbook, checklist, 
journal, or study guide. Take the questions and key points from your 
book and expand them with space for writing. Create a bundle package 
with your book. 
 
• Instead of two books, you could also create a single book/workbook. 
This contains the original book plus a workbook. The original book is a 
single package that has been expanded. Highlight the questions or key 
points in the book and give your reader a place to write down their 
thoughts. You can also add additional resources and content. 
 
• Discussion pages and exercises sheets 
 
• Add a leader or discussion guide 
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• An audio version of your book or program with a companion 
workbook or pages with exercises.  
 
• Take each chapter and create a video that explains or pulls out the 
key points or just asks the questions in a different way. The videos 
match the workbook. You are moving towards a course. 
 
• If you have a podcast or do regular videos you can add a pdf 
downloadable workbook, study guides, or resource sheet. These can be 
one page or more. This could be an add on product to your broadcasts. 
Your podcast is free, the study guides are for pay or free if they sign up 
to your program. It brings people into your world. You collect their 
email addresses for future contact. It brings an entirely new dynamics 
to your content.  
 
• Crossed promoted your book and workbook in the back or front of 
both your books. If you are selling your workbook online then also 
promote the book. The book is the theory, the workbook is the 
practical application. 
 
Another way to look at this process is that we are repurposing your 
content. You wrote it once and now we find additional uses for it. 
 
  



 
 

 © Copyright J. Bruce Jones 2020  •  BruceTheBookGuy.com  •  22 

Resources 
• Tips and Resource Book 
 
• Workbook MasterClass Book 
 
• How to Make a Calendar for Your Workbook in MS Word 
https://www.youtube.com/watch?v=cEPL1vszo7A 
 
• How to Create a Calendar in PowerPoint 
https://www.youtube.com/watch?v=iS9z9i66iH8 
 
• Developing Your Questions 
The Hundred Most Powerful Life Coaching Questions 
https://positivepsychology.com/life-coaching-questions/ 
 
• Teaching Questions 
https://www.edutopia.org/article/important-questions-ask-your-
students 
 
• Online PDF Form Creator 
https://www.pdfescape.com/ 
 
 
 
 
 
 
  



 
 

 © Copyright J. Bruce Jones 2020  •  BruceTheBookGuy.com  •  23 

 
 

Workbook 
Template 
Elements 

 
 

 
 

BRUCETHEBOOKGUY.COM 
© Copyright J. Bruce Jones 2020 

  



 
 

 © Copyright J. Bruce Jones 2020  •  BruceTheBookGuy.com  •  24 

Thank you for joining the Workbook Masterclass. I originally planned on creating 
some full workbook templates for the course. But as I worked on it and got to see 
how people were creating and using their workbooks and journals I realized that 
wasn’t the best approach. What I have created are components pieces, or 
elements that you can copy and drop into your workbooks, journals or 
worksheets. There is also a companion video that goes along with this document 
that shows you how to create each one. Feel free to copy and paste these 
elements for your projects. 
 
Workbook Components 
Interior 
• Title Page 
• Legal Page, copyright 
• Table of Contents, TOC 
• Sections 
• Questions with lines or boxes 
• Charts 
• Checklists 
• Tasks 
• Calendar pages 
• Progress Pages 
• Author Bio 
• Resources 
 
Cover 
• Front cover 

Name, author, subtitle, an image, maybe bullet points 
• Back Cover 

Description, bullet points, contact info, website, phone #, quotes, pictures. If 
you are a business be sure to include your contact info. 
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Header and Footer Graphics 
The graphic at the top of this page is in the Header block of the document. Open View > Header 
and Footer and remove it and replace with your own. Also update or replace the footer 
elements at the bottom for your own document. 
 
How to Make a Simple Header 
A header graphic or even just text gives your book an identity. It ties it to your brand and your 
other products. It can be very simple, just the title, or more complex like the one in this 
document. It also gives your reader all your contact info if they want to reach out to you. You 
never know where your Workbook or Checklists will end up. Having your web address or email 
lets the viewer find you and maybe join your world.  
 
Click on the View pull-down menu and select Header and Footer. You will see a box open at the 
top and bottom of the page. Type in the title of the document or your book, company or course 
name, format it, center it if you want and give it a little space below. At the bottom of the page 
add your copyright info, a web address or maybe your phone number of address. Click on 
Header and Footer again and the boxes will close.  

 
Simple Version 

Workbook Masterclass 
 

CREATE YOUR OWN WORKBOOKS, CHECKLISTS & JOURNALS 
 
 
 

Graphic Version 
 

 
 
 
Watch the video to see how I made this graphic. I usually add an extra space below the header 
graphic or text so that the page text doesn’t bump up against it. 
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Template Elements to Create Your Workbook 
Type your question or action item here and give it 5 or 6 returns for space. 
 
 
 
 
 
Type your question or action item here. Lines are created by holding down the shift key and 
typing the hyphen. Put two spaces between each line or use Format > Paragraph to add space. 
 
___________________________________________________________________________ 
 
___________________________________________________________________________ 
 
___________________________________________________________________________ 
 
___________________________________________________________________________ 
 
 
Type your question or action item here. The box is created by using the Table option. Table > 
Insert. Choose Number of Rows 1, Number of Columns 1. Or as needed. Hit the Return key to 
expand the box as needed. 
 

 
 
 
 
 

 
 
Or two columns, add columns or rows as you need. 
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Type your question or action item here. This is a two column with lines and heads element. This 
is created with the Shift Underline hyphen and some blank space between the columns. 
 
 Option One Option 2 
 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
_____________________________________________________________________________ 
 
 
Create a bullet or numbered list 
 
• __________________________________ • __________________________________ 
 
• __________________________________ • __________________________________ 
 
• __________________________________ • __________________________________ 
 
• __________________________________ • __________________________________ 
 
 
Create a bullet or numbered list 
 
1. _________________________________ 5. _________________________________ 
 
2. _________________________________ 6. _________________________________ 
 
3. _________________________________ 7. _________________________________ 
 
4. _________________________________ 8. _________________________________ 
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There are a number of ways to add bullets and numbers to your documents. There are 
automatic bullet and number option up in the formatting area at the top of the document. 
Those will work but sometimes they can get messy. I am old school on this and like to put them 
in by hand. I like having more control over my elements.  
 
To make a bullet in Mac MSWord, hold down the Option Key and select the number 8 Key. 
Makes a nice bullet. 
 
You can also select Insert from the top menu and choose Advance Element, choose the font 
Wingding and select a bullet. You might have to change the point size of the bullet.  
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For the PC, you also have the same options up at the top for bullets and numbers lists.  
 
Or you can put your curser where you want the bullet to appear, and choose Symbol from the 
Insert menu. Select your font and double-click on the bullet character. Click Close. Once you 
have one bullet you can then just copy and paste the rest. 
 
You can also find bullets in the Home> Paragraph, Bullet Library. 
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Workbooks, checklist, lesson plans and journals can be just questions and lines. 
Be sure to add enough room for your reader, client or student to add their own 
thoughts and reactions. For this page I created the lines using a tab and underline 
leader dots. Adapt this layout to build a question page.  
 
 
1. Question or Task  _________________________________________________  
 
 _________________________________________________________________  
 
 _________________________________________________________________  
 
 
2. Question or Task  _________________________________________________  
 
 _________________________________________________________________  
 
 _________________________________________________________________  
 
 
3. Question or Task  _________________________________________________  
 
 _________________________________________________________________  
 
 _________________________________________________________________  
 
 
4. Question or Task  _________________________________________________  
 
 _________________________________________________________________  
 
 _________________________________________________________________  
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Sometimes we like boxes for our worksheets 
 
1. Question or Task 
 
 
 
 
 

 
 
2. Question or Task 
 
 
 
 
 

 
 
3. Question or Task 
 
 
 
 
 

 
 
4. Question or Task 
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Use boxes to create steps in your training. Let’s say we are teaching a painting class and we 
want to show progress photos of the steps with space for the student to make notes. 
 

Step 1.  Notes: 
 
 
 
 
 
 
 
 
 
 

 
 
 ___________________________________ 
 
 
 ___________________________________ 
 
 
 ___________________________________ 

 
Step 2.  Notes: 
 
 
 
 
 
 
 
 
 
 

 
 
 ___________________________________ 
 
 
 ___________________________________ 
 
 
 ___________________________________ 

 
Step 3.  Notes: 
 
 
 
 
 
 
 
 
 
 
 

 
 
 ___________________________________ 
 
 
 ___________________________________ 
 
 
 ___________________________________ 
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Use the boxes to create the steps in your training. Maybe we are teaching a painting class and 
we want to show progress photos of the steps with space for the student to make notes. 
 

Notching the stool legs  Notes: 

 

 
Layout the page something like this 
 _______________________________________________ 
 
 
_______________________________________________ 
 
 
________________________________________________ 
 

 
Chisel out the waste  Notes: 

 

 
 
_______________________________________________ 
 
 
_______________________________________________ 
 
 
________________________________________________ 
 

 
Legs are ready to go  Notes: 

 

 
 
   _______________________________________________ 
 
 
_______________________________________________ 
 
 
________________________________________________ 
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Put your main question in this area and add lines below to write on. I created 
these lines by holding down the Shift Key and typing on the Underline Key.  
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
 
 
_____________________________________________________________________________ 
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Checklist of key steps, ideas, resources, tasks are very powerful tools in our 
Workbooks. Use this template for people to create a list of their own. The check 
box is Option U and the Wingding font.  
 
 

¨ #1. Write down your key idea.   ______________________  
 
 

¨ #2.   ____________________________________________  
 
 

¨ #3.   ____________________________________________  
 
 

¨ #4.   ____________________________________________  
 
 

¨ #5.   ____________________________________________  
 
 

¨ #6.   ____________________________________________  
 
 

¨ #7.   ____________________________________________  
 
 

¨ #8.   ____________________________________________  
 
 

¨ #9.   ____________________________________________  
 
 

¨ #10.   ___________________________________________  
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Checklist of key steps, resources, tasks are very powerful tools in our Workbooks. 
Use this template to start building your own checklist. The check box is Option U 
and the Wingding font. Checklists are phrases or lines  
 
 

¨ Put your #1 most important item here.  
 
 

¨ Put your #2 most important item here. 
 
 

¨ Put your #3 most important item here. 
 
 

¨ Put your #4 most important item here. 
 
 

¨ Put your #5 most important item here. 
 
 

¨ Put your #6 most important item here. 
 
 

¨ Put your #7 most important item here. 
 
 

¨ Put your #8 most important item here. 
 
 

¨ Put your #9 most important item here. 
 
 

¨ Put your #10 most important item here. 
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Here is a cool element to add to your workbook, MS Word has calendar templates 
in the Template area. Create a new document from the templates, pick a 
calendar, then copy it and paste it into your workbook. There is a lot to choose 
from. If you have trouble getting them into your document, just create a separate 
document. Create a new pdf and combine the pdfs. 

JUL2020 
SUN MON TUE WED THU FRI SAT 

   01 02 03 04 
       

05 06 07 08 09 10 11 
 Click 

here to 
replace 

text. 

     

12 13 14 15 16 17 18 
       

19 20 21 22 23 24 25 
       

26 27 28 29 30 31  
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J. Bruce Jones 

 
J. Bruce Jones is a #1 International Best-Selling Author, Graphic designer, and 
product developer. Bruce writes, speaks and consults on publishing, blogging, 
video and general marketing. I have been teaching and consulting on self-
publishing and indie books for many years.  
 
Bruce is the author and creator of over 50 books, on geography, music, business, 
publishing, children’s and coloring. He is also the creator the World of Maps 
collection. A collection of editable PowerPoint and Illustrator map. Used for 
business, sales presentations, and education worldwide. I love making products. 
Also practices Tai Chi when I get a chance. 
 
Looking for a speaker or guest to interview, I talk on self-publishing and product 
development. Reach out and contact me on Facebook or give a call 781-492-0742. 
 
To learn more about what I am doing please check out my publishing blog, 
BruceTheBookGuy.com http://brucethebookguy.blogspot.com/ 
 
Come over and join the How to Publish Your Book Facebook Group, we have a 
great group of authors publishing books every day. 
https://www.facebook.com/groups/HowToPublishYourBook/ 




